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a. 2. b. 3. d. 4. c 5. a.
F 2.7 3. F 4. F 5T
Microcomputer 2. laptop 3. instructions
programming 5. assembler
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Lets Do It )

A.

IMPRINT 1

1.

Minicomputer is small general-purpose computer having the capability to serve a number
of users simultaneously.

An embedded computer is a special type of microprocessor based system that is developed
for performing a specific task.

C and BASIC are the types of 3GL.
An assembler is a program used to translate assembly language into machine language.

A computer language is the means by which instructions and data are transmitted to the
computer.

A hand held computer is a type of computer that can easily be stored in our pocket and
used by holding it in our hands. The name of two handheld computers are:

a. Smartphones b. Smart watches

Digital computers are computers that use binary numbers (0 & 1) to generate, process and
display data. Examples — Desktop, Laptop.

The differences between HLL and LLL are:

HLL LLL
a. Machine independent a. Machine dependent
b. Easy to understand b. Difficult to understand
Coding contains English words c. Coding is in the form of 0 and 1
or ‘Mnemonics'’
d. Example: C, C++ d. Example: Machine language,

Assembly language
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4. The advantages of High-level languages are:
(i) High-level language is user friendly.
(i) In High-level language it requires less time to write a program.
(iii) High-level language is easier to maintain.
(iv) High-level language is problem oriented rather than ‘Machine Based'.
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2. File Management—Organisation of Data

One Touch Learn )

A. 1. b 2. ¢ 3. ¢ 4. a. 5. a.
B. 1T 2. T 3. F 4. F 5T
C. 1. Fileformat 2. sorting 3. .pptx 4. Partitions 5. asterisk
D. 1 d 2. ¢ 3. e 4. a. 5. b.

Lets Do It

A. 1. Data is arranged in a computer by type, by size, by name and by date of creation and
modification.

Sorting is used to arrange the files in a computer.

Examples of file extensions are .docx and .pptx.

Asterisk(*) and question mark(?) are the types of wildcard characters.

Show windows side by side option is used to open multiple applications in windows.

R

While searching, Asterisk represents a string of characters whereas Question mark represents
a single character while searching.

File Explorer helps us to organise and manage files and folders.
3. The steps to sort the files as per Size are as follows:

Step 1 Right-click on the blank space in the Windows Explorer window. A shortcut menu
will appear.

Step 2 Select the Sort by Size option.

The files and folders will be arranged as per the size of the files.

4. When we work on a computer, we might need to work on more than one files at a time
or open more than one application at a time. For example, while working in a Word file,
we would be using Google for searching and PowerPoint for making presentation. If we
need some images for the presentation, we would have the image folder open in Windows
Explorer as well.

5. We use wildcard for searching when we don't know the location and complete name of
the file.

crack e, code 4

A. 1. Sahil should use cut command instead of copy command.

2. By checking the file extension of both the files, the presentation will have .pptx extension
and Word file will have .docx extension.
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3. Word Processor—Tabular Representation

One Touch Learn )

A. 1. b 2. b 3. ¢ 4. a.
B. 1 F 2. T 3. T 4. F
C. 1. Resizing 2. Merging 3. Layout 4. Design 5. Delete Rows
|
Llets Do It
A. 1. Theintersection of a row and a column in a table is called a cell.
2. Table Styles is a feature with which a user can format the entire table quickly.
3. Shading is an option to apply colors to cell or group of cells in a table.
B. 1. Toaddarow in atable, follow these steps:

Step 1 Select the row of the table where you want to add another row.

Step 2 Click on the Layout tab.
Step 3 Choose Insert Above or Insert Below commands.
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2. Toinsert a table, follow these steps:
Step 1 Click on the Insert tab.
Step 2 Click on the Table command in the Tables group.
Step 3 Click on the Insert Table option. The Insert Table dialog box will appear.
Step 4 Enter the required number of columns and rows you want to insert.
Step 5 Click on OK button. The table will be inserted.
3. To merge two cells, follow these steps:
Step 1 Select the cells to be merged.
Step 2 Click on the Layout tab.
Step 3 Click on the Merge Cells command.
The selected cells are merged as one cell.

4. Splitting cells in a table is dividing one cell into two or more cells whereas Merging
cells in a table is combining two or more cells in the same row or same column into a

single cell.
crack e, code
A. 1. Delete 2. Insert above 3. Insert below
4. Insert Left 5. Insert Right
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4. Word Processor—Mail Merge

One A Touch  Learn o)

A.

Nnw

. a.

1
4
1.
1
3

2. b 3. b
. C 5 a. 6. a.
T 2. F 3. F 4. T
Mail merge 2. Main document
Mailings 4. Write and insert fields

@

Lets Do It )

A.

1
2.
3.
1

Data source is a separate file that contains all information about recipients of the letter.
The name of the command used to add addresses list is Type New List.

Preview Results command is used to see the preview of the merged letters.

Four advantages of Mail Merge are:

(i) It saves time and efforts.

(i) It allows to make changes in several letters very quickly.

(iii) It allows to produce thousands of letters quickly.

(iv) It allows to save the letters as template for later use.

There are three main components of Mail Merge in MS Word which are as follows:

(i) Main Document: It is a document that contains the text of the letter which we want
to send to our friends.

(i) Data Source: It is a separate file that contains all information about recipients of the
letter

(iii) Merged Document: It is the final document created by merging the Main Document
and Data Source. It contains a list of letters with text and detail of a person.

Merged Document is the final document created by merging the Main Document and Data
Source. It contains a list of letters with text and detail of a person.

Crack \The. code b

A.

-

Mail merge feature
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5. Presentation—Visual Effects

One Touch Learn )

A. 1. b 2. a 3. b 4. c 5. a. 6. b.
B. 1 F 2. F 3. F 4. T 5T

C. 1. Insertvideo 2. slide 3. text 4. object 5. create

Let's Do It

A. 1. Slide Show view allows to view the presentation in full screen mode.
2. Transition determines how your presentation moves from one slide to the next.

3. Slide transition determines how presentation moves from one slide to next whereas
Animation is the addition of special visual/sound effects to the text and graphics in a
slide.

w
'_l

. Toinsert sound to a presentation, follow these steps:
Step1l Click on Audio command on the Insert tab.
Step 2 Select the Audio from file option.
Step 3 Navigate and select the audio file to be inserted and click on Insert button.
Step 4 Click on Play button to listen the audio.
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Action button is used to move from one slide to another and play media files. There are
12 different types of action buttons are available in PowerPoint.

Four views in PowerPoint are:
a. Slide Sorter View

b. Notes Page View

¢. Reading View

d. Slide Show View

A. 1. Action button
2. Animation
B. 6
S
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Do your self
Worksheet-1
(Based on chapters 1 to 5)
A. 1. Desktop Laptop
2. PDP-11 PDP-8
3. ATM Microwave
4. Smartphone Smart watch
B. 1. The process of writing a program is called programming.
2. Wildcard is a special character which is used to represent one or more characters.
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A file extension is a group of two or more characters used to identify the type of a file.
Splitting refers to dividing one cell into two or more cells.

The Mail Merge feature in MS Word is used to create personalised letters to be sent to
many people.

Notes pane is the area where a speaker can write notes for himself.

Tables Insert

Cell size Layout
Cell size Layout
Merge Layout

Table styles Design
Hybrid

Natural Languages
Assembler

Right-click

Table Resize Handle
Data Source

Animation

Slide Sorter View

Test Sheet-1

(Based on chapters 1 to 5)

Section A
C. 2. d. 3. ¢ 4. a.
d. 6. a. 7. b. 8. d.
Minicomputer 2. Microcomputer 3. fifth
MP4 5. Borders and shading 6. Mailings
T 2. T 3.7 4. T 5T
Section B

A smart watch is a computing device which you can wear on your wrist. It provides the
features of an older watch and some advanced features of smartphone like connecting to
the internet, using mobile apps, and making phone calls, etc.

PACE, Titan, Sunway Taihulight and Pratyush are the examples of Supercomputer.

Table is very useful in enhancing and analyzing the data.

Merged Document is the final document created by merging the Main Document and Data
Source.

The Notes Page view shows user how notes pages look like in printed form. In this view,
slide of our presentation and the speaker notes that we have added within the Notes pane
for each individual slide appear together.
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A low-level language is a programming languages that is machine dependent. A program
written in machine dependent language runs only on one particular type of computer.

Two low-level languages are: Machine Language and Assembly Language.

A file extension is a group of two or more characters used to identify the type of a file. Two
examples are: JPEG and MP4.

A table is an arrangement of text in form of columns and rows.
Steps to apply a table style:
Step 1 Click anywhere on the table. The Design tab appears on the ribbon.

Step 2 Click and select the design of your choice from the Table Styles group. The selected
style will be applied to the table.

Three advantages of Mail Merge are:

(i) It saves time and efforts.

(i) It allows to make changes in several letters very quickly.
(iii) It allows to produce thousands of letters quickly.

Yes, Object command can be used import data from other applications in a PowerPoint
slide.

6. Scratch Programming—Game Creation

One Touch Learn )

onw»

1
1
1
1
3

.oa. 2. a 3. ¢ 4. a. 5 a

F 2. F 3. F 4. T 5T

Pen 2. regular 3. stamp 4. sound 5. operators
. control block 2. looks block

motion block 4. events block

@/

Lets Do It )

A.

-

1.
2.
3.

Pen blocks in Scratch allow a Sprite to draw shapes and plot coloured pixels on the screen.
The components of Scratch window are Sprite, Stage, Blocks palette and Scripts area.

Block palette contains various predefined blocks that are used to perform specific tasks.
These blocks are used to create scripts in Scratch.

Repeat block is used to draw a pentagon.

Two conditional control blocks are: Forever and Forever—if.

N
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B. 1. The four methods to choose a sprite are:
(i) Paint a new sprite
(i) Choose a sprite from the library
(iii) Upload a sprite from file
(iv) A new sprite from the camera.
2. Blocks are puzzle piece shapes that are used to give instructions to the computer.
Two conditional blocks are: Control and Events.

Crack The Code
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7. HTML—AnN Introduction

One  Touch Learn )

A. 1 a 2. ¢ 3. ¢ 4. d. 5. b.

B. 1 F 2. T 3. F 4. T 5T

C. 1. markup 2. <head> 3. <b> 4. <p> 5. <sub>
QR

Lets Do It 9

A. 1. HTMLis a markup language that describes the structure of the web page.
2. The tags that have both opening and closing tags are called Container Tags.
3. (i) A web page is a document that contains text, graphics, videos, audios and links to
other pages.
(i) A website is a collection of web pages.
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B. 1. The <HTML> tag tells the web browser that the text contained between <HTML> and
</HTML> is a web page and can be viewed using a web browser. Every web page coding
must starts with the <HTML> tag and ends with the </HTML> tag.

The <BODY> tag tells the web browser that the text contained between <BODY> and
</BODY > tags is to be shown on the web page. It is a container tag.

2. Rules for writing HTML codes are:
(i) Values given to the attributes should be enclosed within the double quotes.
(i) Tag name should not contain spaces.
(iii) There should be no spaces between < and > in a tag.
(iv) Tags must be nested correctly.

3. <BR> tag <HR> tag
a. <BR> tag means Line Break tag. a. <HR> tag means horizontal ruler tag.
b. <BR> tag is used when user wantto  b. <HR> tag is used when user want to web
start divide new line. page into different sections.
A. 1 <HR> 2. <u> 3. <BR»>
4. <HTML> 5. <BODY> 6. <H1»>
B. 1 2
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Do yourself.
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8. Internet Services and Cyber Security

One Touch  Learn )

A.
B.
C.

1
1
1

d. 2. a 3. ¢ 4. d. 5. b.
T 2. F 3. F 4. T 5T
Carding 2. E-greeting 3. Chat 4. cyber security

@/

Lets Do It )

A.

1.

Phreaking crime is committed against telephone companies by using computers with the
goal of making free distance calls, impersonating directory assistance or other operator
services, diverting calls to numbers of the perpetrator’s choice, or tapping phone lines.

Newsgroup is the title given to a discussion group. A newsgroup focuses on a particular topic.

Use of social networking services is not advisable for students because these services are
generally considered as a source of distraction from education for students.

Hacking is the practice of modifying computer hardware and software to accomplish a goal
outside of the creator’s original purpose.

A cloud storage is a service where the users are able to store and manage data on remote
server in place of their local computer.

Four Safety measure while using Internet are:

(i) Never provide personal information, such as address, phone number, or school name
or location.

(i) Keep our browser's privacy settings ON.

(iii) Use the Internet only in the presence of our elders.

(iv) Do not share passwords (other than our parents or teachers).

Different types of Communication techniques are:

(i) E-mail: E-mail stands for electronic mail. We can send messages and files from our
computer to your friend's computer and vice-versa using e-mail service. It is fast and
generally delivered within few seconds (depending on the network speed) after sending.

(i) Video Conferencing: We use telephones and mobiles to talk to your friends and
relatives. With the advancement in technology, we can now see the person with whom
we are talking. The technique of watching the person while talking to him is called video
conferencing. In video conferencing, there can be two or more persons at different
locations simultaneously talking to each other by both audio as well as video.

(iii) Voice-over-Internet Protocol (VoIP): Voice-over-Internet Protocol (VoIP) is a
technology which gives calling facility over the Internet. It is basically used for voice
communications.

| W
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3. The differences between hacking and cracking are:
Hacking Cracking

a. Practice of modifying computer a. Process of stealing personal information.
hardware and software.

b. People engaged are called as hackers.  b. People engaged are called as crackers.

4. There are various types of cyber threats. Some of them are as follows:
(i) Data Diddling: Refers to the process of changing the data going into or out of a
computer.

(i) Phreaking: This crime is committed against telephone companies by using
computers with the goal of making free distance calls or tapping phone lines.

(iii) Cloning: This refers to a fraud in which scanners are used to steal the electronic serial
numbers of cellular phones, which may used for billing purposes and making broadcast
calls.

(iv) Carding: This refers to the process of stealing credit card numbers online, to be resold
or used to charge merchandise against victim's account.

(v) Hacking and Cracking: Computer hacking is the practice of modifying computer
hardware and software to accomplish a goal outside of the creator’s original purpose.

(vi) Cracking: The process or stealing personal information, changing financial data, breaking
security systems to gain unauthorized access of computer systems is called cracking.

 crock [The. Code L

A. 1. E-banking 2. No, this is a wrong way.
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9. E-mail—An Introduction

One  Touch  Learn )

A.
B.
C.

1
1
1

C. 2. a. 3. d. 4. b. 5. ¢ 6. C.
F 2. F 3. F 4. T 5 T 6. F
Bcc 2. To 3. Cc 4. Attachment 5. Sent

@4

Lets Do It )

A.

A.

Hw N

=

1
2.
3.

Internet is a computer network that connects hosts and end systems throughout the world.
We use emoticons to represent facial expressions.
Yes, we can send a video file as attachment in an e-mail.

An electronic mail or e-mail cab be defined as the process of exchanging messages
electronically through a communications network by clicking on it.

Signing in is the process to open a session with an account that is already created. To sign
in, double-click on web browser icon — click on sign in button — Enter user name and
password — click on Next button.

E-mail has various advantages, some of them are:

1. An e-mail can be sent anytime and from anywhere in the world.

2. Ane-mail can be sent to many people at a time.

3. An e-mail can be easily forwarded to anyone without typing it again.

4. Sending an e-mail is fast in comparison to traditional mails.

E-mail has several features. Some of them are as follows:

1. Ability to attach the files along the message.

2. Ability to store the information such as message and contact list.

3. Ability to send Multipurpose Internet Mail Extensions (MIME) type files.

He can send music file by using attachment option.
Ajay's e-mail id in 'to’ field and others e-mail address in '‘BCC’ section.
He should log out of his e mail account.
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10. More on Internet

One Touch Learn )

A. 1 a 2. a 3. b
4. d. 5 a
B. 1 F 2.7 3.7
4 F 5 T
C. 1. blog 2. blogger 3. online 4. cash on delivery 5. drive

Lets Do It

A. . Google Docs option is used to create word file on Google Drive.

1

2. Two modes of payment are Net Banking and E-Wallet.
3. OTP stands for one time password.
4

. Two e-commerce websites are www.amazon.com and www.flipkart.com.
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B. 1. Ablogorweblogisaninformational website that often contains information on a particular
subject. Podcasts and Photologs are types of blogs.

2. The process of making digital recordings (audio or video) that are available for downloading
is called podcasting.

Podcasting services are https://itsamonkey.com/ and http://revisionisthistory.com.
3. E-commerce has several advantages. Some of them are:

(i) It allows us to choose a product from a broad range of products.

(ii) It saves our money and time.

(iii) It allows us to sell or buy products and services at any time.

Crack \The. code I

A. 1. www.blogger.com
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Worksheet-2

(Based on chapters 6 to 10)

A. 1. Backdrop is a background of the stage.
Sprite is an object that we see on the scratch stage.

3. Stage is the main working area to draw or perform action. It shows the output of the
program.

4. Scripts area is the area where we pick and drop the blocks from the Blocks Palette to create
a script/program.

5. Green Flag is used to run a scratch program.
B. 1. Adobe Dreamweaver Amaya
2. <BR> <HR>
3. Communication E-Banking
4. Net Banking E-Wallet
C. 1. Pen
2. Stamp
3. Web browser
4. Container Tag
5. Attribute
6. Newsgroup
7. Cloud Computing
8. Spam
D. 1. Hyper Text Markup Language
2. Standard Generalized Markup Language
3. Asynchronous Transfer Mode
4. One Time Password
5. Common Business Oriented Language
Test Sheet-2
(Based on chapters 6 to 10)
Section A
A. 1 a 2. c 3. ¢ .
5. d 6. d. 7. a. 8.
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F 2. T 3. F 4. T 5 F
Sound 2. body 3. e-greeting 4. Outbox 5. google
Section B

Repeat Block is used to draw a Pentagon.
Empty tags contain only opening tag. They do not have closing tag.
In place of </h4>, </h1> should be used.

Hacking is the practice of modifying computer hardware and software to accomplish a goal
outside of the creator’s original purpose.

Compose button on Gmail is used to create and type a new mail.
The meaning of F9 acronym in an e-mail is Fine.

Blocks are puzzle piece shapes that are used to give instructions to the computer.
Four pen blocks are:

(i) Penup

(i) Pen down

(i) Stamp

(iv) Set pen color to

The <Body> tag tells the web browser that the text contained between <Body> and
</Body> tags is to be shown on the web page. It is container tag. Two attributes are:

(i) BGCOLOR

(i) TEXT

<html>

<head> </head>

<body>

Chemical formula for Sulphuric acid is H<sub>2</sub>SO<sub>4</sub>.

<BR> Maths formula for (A + B) <sup>2</sup> is A<sup>2</sup> + B<sup>2</sup>
+ 2AB.

</body>
</html>

Four Safety Measures while using Internet are:

(i) Never provide personal information, such as address, phone number, or school name
or location.

(i) Keep the browser's privacy settings ON.

(iii) Use the Internet only in the presence of the elders.

(iv) Do not share passwords (other than the parents or teachers).
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5. orangeeducation123 is the user name and gmail.com is domain name.

The process of buying and selling goods or services online is called e-commerce. The
e-commerce is also known as electronic commerce.

The three Payment modes are:
1. Debit or Credit Card

2. Net Banking

3. E-Wallet
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